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Verwendung von LibreOffice unter macOS

Einige Tastenbelegungen und Menteintrage unterscheiden sich zwischen der Macintosh-Version
und denen fir Windows- und Linux-Rechner. Die unten stehende Tabelle gibt Ihnen einige grundle-
gende Hinweise dazu. Eine ausfihrlichere Aufstellung dazu finden Sie in der Hilfe der jeweiligen
Komponente.

In Windows/Linux  entspricht unter macOS  Effekt

Menu
Extras > Optionen

LibreOffice > Einstellungen  Zugriff auf die Programmoptionen

CTRL+KLICK und/oder
RECHTSKLICK RECHTSKLICK je nach Offnen eines Kontextmenus
Einstellungen

Tastenkirzel in Verbindung mit anderen

STRG (Steuerung) &8 (Command) Tasten
ALT ~ und/oder Alt oder Option Ez:ggki]rzel in Verbindung mit anderen
F11 %+T Offnen d_er Formatvorlagen in der
Seitenleiste
Synonyme
In diesem Dokument verwendete Synonyme:
far in diesem Dokument verwendet
Abschnitt Bereich
Deck Bereich
Dialogfeld, Dialogbox Dialog
Anfasser (Punkte am Ende einer Symbolleiste)  Griff(e)
Menduleiste, Hauptmendi, Men
Register, Reiter Tab
Tabulator Tabulator
Objektpunkte (quadratisch, rund, oval) Ziehpunkte

Sie sehen vielleicht etwas anderes

LibreOffice lauft auf Windows, Linux, Mac OS X, FreeBSD und anderen Unix-Varianten, von denen
jedes Betriebssystem unterschiedliche Versionen hat und kann von den Nutzern beziglich Schrift-
arten, Farben und Themen angepasst werden.

Die Bilder in diesem Handbuch wurden mit hellem Thema in Ubuntu 20.04 erstellt. Das LibreOffice
Thema entspricht der Werkseinstellungen.
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Einleitung

Formeln

In eine Zelle kann direkt eine feste Zahl oder ein Text eingegeben werden. Der Inhalt einer Zelle
soll jedoch oftmals vom Inhalt anderer Zellen abh&ngen. Um dies zu erreichen, verwendet man
eine Formel. Formeln sind Gleichungen, die ein Ergebnis aus Zahlen und Variablen berechnen.
Variablen sind Zelladressen in einer Tabelle, die entsprechende Eingangswerte fiir die Gleichung
enthalten.

Funktionen

Eine Funktion ist eine vorbereitete Berechnungsvorschrift und wird in eine Zelle eingetragen, um
Daten zu analysieren oder zu bearbeiten. Man fugt Argumente ein, die Berechnung erfolgt dann
jeweils automatisch. Funktionen helfen, die Formeln zu erstellen, die man fir ein gewilinschtes
Ergebnis bendtigt.

Eine Tabelle erstellen

Um mit Calc eine Datei mit mehr als einer einzelnen einfachen Tabelle zu erstellen, ist es hilfreich,
etwas vorauszuplanen. Man sollte:

» in Formeln keine festen Zahlenwerte sondern diese besser in eigene Zellen eintragen, siehe
Die Falle der festen Werte,

» Kommentare in den Zellen und Notizen in daneben liegenden Zellen als Dokumentation
hinzufigen, in denen beschrieben wird, was der Zweck einer Formel ist, welche Eingaben
erwartet werden und, falls sie nicht ganz von neuem erstellt wurde, woher die Formel stammt,
siehe Fehlende Dokumentation, und

» ein System zur Fehlererkennung in Formeln aufbauen, um sicherzustellen, dass die Formeln
das ergeben, was beabsichtigt wurde, siehe Fehlererkennung.

Die Falle der festen Werte

Viele Benutzer erstellen lange und komplexe Formeln mit direkt in die Formel eingegebenen festen
Werten. Zum Beispiel braucht es zur Umwandlung einer Wahrung in eine andere den Umrech-
nungskurs. Wenn man in die Zelle C1 eine Formel =0,75*B1 eingibt, um aus dem Betrag in US-$ in
der Zelle B1 den Betrag in Euro zu errechnen, muss die Formel bearbeitet werden, wenn sich der
Umrechnungskurs von 0,75 andert. Viel leichter ist es, eine Eingabezelle mit dem Umrechnungs-
kurs zu erstellen und sich auf diese Zelle in jeder Formel zu beziehen, die den Umrechnungskurs
bendtigt. Was-ware-wenn-Berechnungen werden dann auch einfacher: Was wére, wenn der
Umrechnungskurs sich von 0,75 in 0,7 oder 0,8 andert? Kein Bearbeiten der Formel ist nétig und
es wird klar, welcher Kurs in der Berechnung verwendet wird. Komplexe Formeln in besser
handhabbare Teile zu zerlegen, vermindert auch Fehler und Problemsuche.

Fehlende Dokumentation

Fehlende Dokumentation ist eine sehr haufiges Problem. Oft wird eine einfache Tabelle erstellt, die
sich dann mit der Zeit zu etwas sehr Komplexem entwickelt. Ohne Dokumentation ist die urspriing-
liche Absicht und der Lésungsweg unklar und ist schwer zu erkennen. Dann ist es meist einfacher,
vor vorne zu beginnen, damit aber bereits getane Arbeit zu verlieren. Mit Kommentaren in den
Zellen, mit Kennzeichnungen und Beschreibungen kann ein Tabellendokument vom Autor selbst
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und auch von anderen spater viel leichter verandert werden, sodass viel Zeit und Aufwand einge-
spart werden kann.

Fehlererkennung

Daten in Spalten oder in Zellbereichen zu addieren flhrt oft zu Fehlern, weil Zellen ausgelassen,
Bereiche fehlerhaft angegeben oder Zellen mehrfach einberechnet werden. Sinnvoll ist dabei,
Prifungen in der Tabelle anzulegen. Zum Beispiel sollen in einer Tabelle Zahlenwerte in mehreren
Spalten addiert werden, dazu wird die Funktion SUMME verwendet. Das Ergebnis kann tberpruft
werden, indem die Summen der Zeilen in einer nicht gedruckten Spalte berechnet werden. Die
Summe der Spaltensummen und die Summe der Zeilensummen muss Ubereinstimmen, andern-
falls ist irgendwo ein Fehler.

L . A B C D E
Man kann auch mit einer Formel eine 1 A B c Reihensummen:
Fehlermeldung anzeigen, wenn die Werte 2 0,36 0,33 003 0,72

H 0 H H H H 3 0,7 0,93 0,12 N 1,83
nlch_t Ubereinstimmen (siehe Zelle E10 in 2 012 084 042 . 138
Abbildung 1). 5 0,51] 0,72 027 & 15

. _ 6 0,46 0,48 014 1,08

Um das Auffinden von Problemen in 7 0.9 0,22 038 . 152
Formeln zu unterstiitzen, bietet Calc eine g =SUMME(AS:AT) N 136w 8,03
Anzeigeeinstellung an, mit der alle Zellgn in 1 Summe: 767 ghler!
einer Tabelle hervorgehoben werden, die 11
Formeln enthalten. Diese Einstellung ist 12 =WENN(C10<>E8;"Fehler!!";"OK")

standardmaRig ausgeschaltet und wird
eingeschaltet in Extras > Optionen >
LibreOffice Calc > Ansicht mit Formelanzeige und Hinweis. Calc kennzeichnet dann die Zellen,
die Formeln enthalten, mit einem Dreieck in der linken unteren Ecke und zeigt die Formel an, wenn
der Mauszeiger Uber die Zelle fahrt. Im gleichen Bereich kann Werthervorhebung aktiviert werden,
sodass Text, Zahlen und Formeln in unterschiedlichen Farben dargestellt werden (siehe ebenfalls
Abbildung 1).

Abbildung 1: Fehlererkennung
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Formeln

Formeln kdnnen auf zwei verschiedenen Wegen eingegeben werden.

Der eine Weg ist, die Funktion direkt in die Zelle oder in die Eingabezeile einzugeben. Eine Formel
beginnt mit dem Zeichen =, das als erstes eingegeben werden muss. Wenn eine Eingabe jedoch
mit + oder — beginnt (z. B. -2*A1), fugt Calc selbsttatig ein = hinzu, auf3er wenn man nur eine
positive oder negative Zahl eingibt (z. B. -2 oder +3). Beginnt die Eingabe mit einem anderen
Zeichen, dann wird die Zelle als Text interpretiert. Bei der Eingabe von Funktionen direkt in die
Zelle oder die Eingabezeile unterstitzen die Hilfetipps (siehe Abschnitt AutoEingabe und
Hilfetipps).

Der andere Weg ist der Funktionsassistent (siehe Abschnitt Funktionsassistent) oder die entspre-
chende Mdéglichkeit im Register Funktionen der Seitenleiste (siehe Abschnitt Funktionen in der
Seitenleiste).

Operatoren in Formeln

6
Jede Zelle in einer Tabelle kann verwendet werden, um Daten aufzunehmen ?l—ll
oder um Berechnungen auszufiihren. Um Daten einzutragen, wird einfach in die
Zelle hineingeschrieben und zu einer anderen Zelle gewechselt oder die
Eingabetaste gedrickt. Bei Formeln bestimmt der Beginn mit dem Gleichheits-
zeichen, dass die Zelle fur Berechnungen verwendet wird. Ein Beispiel fur die Abbildung 2:
Berechnung direkt in einer Zelle zeigt Abbildung 2. Die Zelle enthlt die Formel Berechnung in
=15+46, das Ergebnis 61 wird angezeigt. einer Zelle

Wie die Daten und die Berechnung in verschiedene Zellen aufgeteilt werden
kénnen, zeigt Abbildung 3. Hier tragen die Zellen A2 und A3 die Daten und A

die Berechnung wird in A4 durchgefiihrt. Die Formel lautet =A2+A3. Das 1

Zeichen + bedeutet, dass die Inhalte der Zellen A2 und A3 addiert werden 2 15
sollen, das Ergebnis ist damit in der Zelle A4 enthalten. Alle Formeln funktio- i gﬁ
nieren nach diesem Prinzip. Weitere Beispiele, Formeln zu benutzen, sind in 5 ﬁ
Tabelle 1 aufgefiuhrt. 6
Die Zellenbeziige erméglichen, dass Daten von allen Zellen in der Tabelle ;

und auch aus einer anderen Tabelle fir die Berechnung verwendet werden Abbildung 3:
kdnnen. Daten in einer anderen Tabelle werden durch Angabe des Namens Berechnung in
der Tabelle angegeben, z. B. mit der Formel =$Tabelle2.A2+$Tabelle3.A3. getrennter Zelle

Hinweis

Um ein Gleichheitszeichen nicht zur Kennzeichnung einer Formel sondern als Text zu
verwenden, wird ein einzelnes einfaches Anflihrungszeichen vor dem = eingegeben,
z. B. behandelt Calc die Eingabe "=Gesamtzahl einschliel3lich des = als Text.

Tabelle 1: Beispiele der Formelverwendung

Formel Ergebnis
=A1+10 Inhalt der Zelle A1 plus die Zahl 10
=A1*16% 16% des Inhalts der Zelle A1
=A1*A2 Produkt der Zellen A1 und A2
=RUNDEN(A1,1) Inhalt der Zelle A1 gerundet auf 1 Dezimalstelle

Formeln 8



Formel Ergebnis

=EFFEKTIV(5%,12) jahrliche Effektivverzinsung zu einer Nominalverzinsung
von 5% bei 12 Zinszahlungen pro Jahr

=B8-SUMME(B10:B14) Inhalt der Zelle B8 minus der Summe aller Zellen von B10
bis B14

=SUMME(BS8, SUMME(B10:B14)) Summe des Inhalts der Zelle B8 und aller Zellen von B10
bis B14

=SUMME(B1:B1048576) Summe aller Zellen in Spalte B

=MITTELWERT(Preisliste) Mittelwert der Zellen, die als Bereich unter dem Namen

Preisliste definiert wurde (siehe Tabelle > Benannte
Bereiche > Festlegen)

=WENN(C31>140, “zu grol3”, wenn der Inhalt der Zelle C31 groRer als 140 ist, dann der Text
“gut”) »ZU grof3”, andernfalls der Text ,gut”

In Calc gibt es arithmetische Operatoren, Vergleichsoperatoren, einen Textoperator und
Bezugsoperatoren.

Arithmetische Operatoren

Arithmetische Operatoren sind die vier Grundrechenarten sowie Exponent, Prozent und Negation
(siehe Tabelle 2). Sie liefern numerische Ergebnisse.

Tabelle 2: Arithmetische Operatoren

Operator Funktion Beispiel

+ (Pluszeichen) Addition =1+1

- (Minuszeichen) Subtraktion =2-1

* (Stern) Multiplikation =2*D

/ (Schrégstrich) Division =10/5

N (Zirkumflex, Caret) Exponent (Potenzierung) =2"3

% (Prozentzeichen) Prozent, links verknipft 15%

- (Minuszeichen) Negation, rechts verknupft -5

Der Operator % hat die arithmetische Bedeutung “/100. Bei einer Multiplikation oder Division mit
einer Zahl wird die /100 verrechnet und der Wert verliert die Formatierung %. Bei einer Addition
oder Subtraktion einer Zahl wird die Zahl mit 100% multipliziert und die Formatierung % bleibt
erhalten (siehe Beispiele in Tabelle 3).

Rangfolge der arithmetischen Operatoren

Daten und Operatoren werden nicht zwingend von links nach rechts bearbeitet, wie es geschriebe-
nem Text entspricht. Stattdessen haben die arithmetischen Operatoren den Regeln der Mathema-
tik entsprechend unterschiedliche Rangfolge (Prazedenz), siehe
https://de.wikipedia.org/wiki/Operatorrangfolge.

Formeln 9
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Die Negation und Prozent haben als unare Operatoren den hdchsten Vorrang, dann folgen die
binaren Operatoren Potenzierung (Exponent), dann Multiplikation und Division und schlief3lich
haben Addition und Subtraktion den geringsten Vorrang.

Mit den runden Klammern (und ) in der Formel kann die Reihenfolge der Operationen unabhéngig
von der Rangfolge gewahlt werden, d.h. die Klammern haben einen noch héheren Vorrang als die
arithmetischen Operatoren.

Die Verkettung von Text (siehe unten den Abschnitt Textoperator) hat einen noch geringeren
Vorrang als die arithmetischen Operatoren, die Ergebniszahl wird als Text interpretiert.

Tabelle 3: Beispiele der Operatorrangfolge

Funktion Ergebnis Anmerkung

=1+3*2+3 10 1+ (3*2) + 3, nicht: (1+3) * (2+3)

=(1+3)*(2+3) 20 4*5, Klammern, um die Reihenfolge anders zu wahlen

=372 9 (-3)"2, darum positiv, nicht: -(3"2)

=5*2n3 40 5 *(2"3), nicht: (5*2) * 3

="Text"&12+5 Textl7 12+5 wird zuerst berechnet, danach mit "Text" verkettet
=200*5% 10 200 * 5 * /140, die Formatierung % entfallt bei * und /
=1-5% 95% 100% - 5%, die Formatierung % bleibt bei + und - erhalten
Vergleichsoperatoren

Vergleichsoperatoren werden haufig in Formeln eingesetzt, die die Funktion WENN verwenden,
und ergeben das Ergebnis WAHR oder FALSCH, beispielsweise ist 12>7 WAHR, aber 12<7 ist
FALSCH. Die Formel =12>7 bzw. =12<7 kann auch direkt in die Zelle eingegeben werden, das

Ergebnis ist der logische Wert WAHR oder FALSCH.

Die verfugbaren Operatoren sind in Tabelle 4 aufgefihrt.

Tabelle 4: Vergleichsoperatoren

Operator Name Beispiel (A1=4, B1=5) und Anmerkung
= gleich Al1=B1 » FALSCH
> groRer als Al1>B1 » FALSCH
< kleiner als Al<B1 » WAHR
>= gréRer oder gleich Al1>=B1 » FALSCH ; das Gegenteil von kleiner als
<= kleiner oder gleich Al<=B1 » WAHR ; das Gegenteil von gréRer als
<> ungleich Al1<>B1 » WAHR ; das Gegenteil von gleich

Wird das Ergebnis einer Vergleichsoperation in einer arithmetischen Operation verwendet (siehe
Abschnitt Arithmetische Operatoren), dann hat WAHR den Wert 1 und FALSCH den Wert 0, das
Ergebnis als Text verwendet (siehe Abschnitt Textoperator) ergibt den Text “1“ bzw. “0”.

Formeln 10



Textoperator

| C1 ‘ v | fx & + =[=WENN(A1>B1;,C2;D2)
In vielen Fallen wird Text in einer Tabelle N B' c b E
verwendet. Um eine flexible Darstellung 1 15 o aroer
von Text zu erméglichen, kann Text aus 2 |Die Zahl ist groRer nicht gréRer als
Teilen, die von verschiedenen Stellen in 3 |Die Zahl 15yst nicht groBer als 17

der Tabelle stammen, zusammengesetzt
werden. Dies ist die Verkettung, der
entsprechende Operator ist das Und- Abbildung 4: Verkettung

Zeichen &. Abbildung 4 zeigt ein Beispiel

dazu: A1 und B1 sind Zahlen, in C1 wird der passende Text C2 oder D2 aus einem Vergleich der
Zahlen errechnet (siehe Darstellung der Eingabezeile), in A3 werden alle Textfragmente zu einem
Ergebnistext verkettet. Bitte beachten, dass die Textfragmente teilweise Leerzeichen enthalten.

Die Funktion VERKETTEN bietet diese Mdglichkeit des Operators & ebenfalls an.

=A2 & A1&B2&C1 &E2 &B1

Bezugsoperatoren

Ein Bezug verweist auf eine einzelne Zelle, die Zelle wird gekennzeichnet durch einen Buchstaben
fur die Spalte und eine Zahl fur die Zeile seiner Position in der Tabelle. Am oberen Rand des
Arbeitsbereichs sind die Spaltenkdpfe beginnend mit A, am linken Rand die Zeilenkdpfe beginnend
mit 1 zu finden. In der linken oberen Ecke befindet sich die Zelle A1.

Ein in einer Zelle eingetragener Bezug kann eine relative oder eine absolute Angabe sein (siehe
unten die Abschnitte Relativer Bezug und Absoluter Bezug). Der relative Bezug ist Standard.

Der einfachste Bezug zeigt auf eine einzelne Zelle, Bezilige kénnen jedoch auch auf mehrere
nebeneinander liegende Zellen, auf ein ganzes Rechteck oder sogar auf einen rdumlichen Quader
von Zellen zeigen. Zur Beschreibung solcher Bezlige gibt es Bezugsoperatoren.

Bereichsoperator

Mit dem Bereichsoperator wird durch die Angabe zweier durch einen Doppelpunkt : getrennter
Zellen ein rechteckiger Zellbereich ausgewahlt, siehe ein einfaches Beispiel B2:C4 in Abbildung 5.

= Die erste der angegeben Zellen hat den kleineren oder | 2:ca | wEe=[
gleichen Wert von Zahl und Buchstabe, d. h. es wird A B | ¢
immer die linke obere und die rechte untere Ecke einge- 1
tragen. Tippt man andere Werte in die Angabe ein, so % i
wird der Bereich automatisch umgewandelt. 4

= Wird nur ein Buchstabe angegeben, dann bezeichnet ~ Abbildung 5: Beispiel Zellbereich
dies die ganze Spalte, nur eine Zahl bezeichnet die
ganze Zeile.

= Anstelle einer einzelnen Zelle kann jeweils wiederum ein Bereich angegeben, d.h. Bereiche
verschachtelt angegeben werden. Dies macht insbesondere bei einem benannten Bereich
Sinn. Damit wird der Zellbereich auf das alle Zellen und Bereiche umfassende Rechteck
erweitert, z. B. (A2:B4):C3 ergibt A2:C4.

= Ein oder auch zwei benannte Bereiche kdnnen angegeben werden, siehe unten im
Abschnitt Benannter Bereich.

In Tabelle 5 finden sich zulassige Beispiele fiir Zellbereiche.
Tabelle 5: Beispiele fir Zellbereiche

Zellbereich Anmerkung
A2:B4 ein Rechteck mit 6 Zellen, 2 Spalten breit x 3 Zeilen hoch
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Zellbereich Anmerkung

(A2:B4):C3 das Rechteck A2:B4 wird bis C3 nach rechts erweitert, sodass sich
9 Zellen ergeben, 3 Spalten breit x 3 Zeilen hoch

Tabelle1.A3:Tabelle3.D4  ein Quader mit 24 Zellen Uber 3 Tabellen x 4 Spalten x 2 Zeilen
(vorausgesetzt es existieren 3 Tabellen von Tabellel bis Tabelle3)

B:B alle Zellen der Spalte B
A:D alle Zellen der Spalten A bis D

20:20 alle Zellen der Zeile 20
1:20 alle Zellen der Zeilen 1 bis 20

Schnittmengenoperator A B c

Der Schnittmengenoperator wird durch ein Ausrufezeichen !
gewahlt. Damit wird die Schnittmenge von zwei Zellbe-
reichen bestimmt, d. h. nur die Zellen, die beiden der
angegebenen Zellbereichen angehéren, werden so ausge-
wahlt. Von den beiden Bereichen A2:B4 (in Abbildung 6 blau = :
umrandet) und B3:C6 (orange umrandet) ist die Schnitt- Abbildung 6: Schnittmenge und
menge A2:B4/B3:C6 nur die Zellen B3 und B4 (rot vereinigung

umrandet).

~ ||| B (WA=

Vereinigungsoperator

Der Vereinigungsoperator (Verkettung) wird durch eine Tilde ~ gewahlt. Damit wird die Menge von
Zellbereichen bestimmt, die einem oder beiden der angegebenen Zellbereichen angehdéren. Von
den beiden Bereichen A2:B4 (in Abbildung 6 blau umrandet) und B3:C6 (orange umrandet) ist die
Vereinigungsmenge A2:B4~B3:C6 alle grin hinterlegten Zellen, die Zellen B3 und B4 (rot umran-
det) sind dabei zweimal enthalten.

Vorsicht

Eintrége, die in beiden Zellbereichen enthalten sind, werden zweimal verwiesen.

Rangfolge der Bezugsoperatoren

Unter den Bezugsoperatoren hat Bereich die hdchste Prioritat, danach die Schnittmenge und
schlie3lich die Vereinigung mit geringster Prioritét.

Der Ausdruck B1:B9!D1:D9~A4:E5 wird z. B. gewertet wie ((B1:B9) ! (D1:D9)) ~ (A4:E5).

Relativer Bezug

Wird eine Zelle, die einen relativen Bezug enthalt, A B C D
kopiert und an anderer Stelle eingefligt, so wird 26

der Bezug in der Zelle an die neue Position 2 ? X
angepasst. In Abbildung 7 wurde zur Demons- 29 L =A27+B27, =B27+C27, =C27+D27
tration mit Ansicht > Formel die Darstellung 30

geandert. Die Zelle C29, die die Summe aus den  Abbildung 7: Beispiel relativer Bezug

beiden Zellen B27 und C27 bildet (blaue Pfeile),
wurde kopiert und nach links und rechts auf B29 und D29 eingefligt. Durch das Einfligen an
anderer Stelle wurden die Bezlige angepasst, sodass sie relativ unverandert sind. Wahrend in C29
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die Zahl 7 (3+4) errechnet wird, ergibt B29 die Zahl 3 (ein leeres Feld + 3, griine Pfeile) und D29
ergibt 4 (4 + ein leeres Feld, orangene Pfeile).

Wird also beispielsweise der Ausschnitt einer Tabelle mit Zeilen- und Spaltensummen oder
anderen Bezligen innerhalb des Ausschnitts kopiert und an anderer Stelle eingefiigt, so werden
alle Bezlige so angepasst, dass sich die kopierten Summen oder anderen Ergebnisse auf die
kopierten Tabelleninhalte beziehen.

Absoluter Bezug
. , . i A B C D

In einer Tabelle soll oftmals ein an vielen anderen Stellen 1
verwendeter Wert an zentraler Position eingetragen 2 4,50 Bearbeitungsgebiihr
werden, z. B. ein Wahrungskurs oder ein Steuersatz. Wird | 3 609 kg 5g
eine Formel, die diesen Wert verwendet, von einer Stelle : 5 |Porto 2,50 4,00 7.50
zur anderen kopiert, so wirde bei einem relativen Bezug | 6 |Zucker |\ 750y 11,50y 25,00
nicht mehr der gewiinschte Wert erreicht. Daher gibt es die vl » 790 270 2059

- L " eis .  7.65. 1230, 29,00
Mdglichkeit, einen Bezug als absolute Position anzugeben, 9
so dass weiterhin dieser Wahrungskurs oder Steuersatz ; 1? =3,8+CS5+5AS2

verwendet wird. = -
Abbildung 8: Beispiel absoluter Bezug

Der absolute Bezug wird in der Zellangabe durch ein voran-

gestelltes Dollarzeichen $ gekennzeichnet. Sowohl die Spalte als auch die Zeile kénnen
unabhéangig voneinander als absolut gekennzeichnet werden. Mit Tabelle > Zellbezugsarten
wechseln oder der Funktionstaste F4 kann durch die 4 Mdglichkeiten Bezug relativ — Zeile und
Spalte absolut — nur Zeile absolut — nur Spalte absolut gewechselt werden.

Abbildung 8 zeigt ein Beispiel, in dem die Zellen der Preisstaffelung kopiert und eingefiigt werden
kénnen und sowohl der Bezug zum Porto (C$5 — die Zelle in Zeile 5 der gleichen Spalte) als auch
zur Bearbeitungsgebihr ($A%$2 — die Zelle an der festen Position A2) werden richtig Ubernommen.

Bezug in eine andere Tabelle

Bezlige Uber die Grenzen einer Tabelle hinweg ermdglichen eine bessere Strukturierung des
Dokuments. Werden dabei die Tabellen aussagekréftig benannt, dann sind Bezlige zudem gut zu
verstehen und zu pflegen.

Die Zelle in einer anderen Tabelle wird adressiert, indem der Zelladresse ein Dollarzeichen $, der
Name der Tabelle und ein Punkt . vorangestellt wird, z. B. $‘Umsatz Nord’.D7. Sofern der Name
der Tabelle ein Leerzeichen enthalt oder nur aus Ziffern besteht, muss der Name in einfache
Anflhrungszeichen ‘ eingeschlossen werden.

Die Zelladresse kann noch einfacher eingegeben werden, indem beim Bearbeiten einer Formel auf
den Reiter der Tabelle geklickt und dann die Zelle in der Tabelle angeklickt wird.

Damit kénnen zum Beispiel Zahlen aus mehreren Tabellen zu einer Gesamtsumme zusammenge-
fuhrt werden, siehe Abbildung 9.

| a ‘ v | fxL-= \ =$'Umsatz Nord'.D7+$'Umsatz Sud'.D7+$'Umsatz West'.D7 |'

A | 8 NN O E F G

L2
“Umsatze gesamt.

| 1K w34 Umsatz Mord Umsatz sid Umsatz West Globaler Umsatz
|
¥ Tabelle 4von 4 Standard Deutsch (Deutschland) =] T @ 100%

Abbildung 9: Bezug in eine andere Tabelle
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Wird eine Tabelle umbenannt, so werden die Bezlige zu dieser Tabelle automatisch ebenfalls
entsprechend geandert.

Bezug in eine andere Datei

Ein Bezug kann sogar eine Zelle in einer anderen Datei adressieren. Hierzu wird die URL (Uniform
Resource Locator) der Datei in einfache Anfihrungszeichen ‘ eingeschlossen und eine Raute #
vorangestellt. Eine Datei auf dem gleichen Computer wird mit file:/// und dem absoluten Pfad der
Datei adressiert, z. B.

='file:///home/Benutzer/Dokumente/UmsétzeNordSlidWest.ods #$'Globaler Umsatz'.C3.

Die URL kann entsprechend auch eine Adresse im Internet sein, z. B.
='https://wiki.documentfoundation.org/images/c/ce/Grundrechenarten_in_Calc_V6.0ds'#$'Grund-
rechenarten'.E8.

Unter Extras > Optionen > LibreOffice Calc > Allgemein wird eingestellt, wann diese Verknip-
fungen aktualisiert werden sollen. Unter Bearbeiten > Verkniipfungen zu externen Dateien im
Dialog Verkniipfungen bearbeiten kdnnen die Verknupfungen bearbeitet und manuell aktualisiert
werden, mit Lésen wird der Inhalt des Bezugs als Kopie in der Zelle abgelegt und die Verknip-
fung geldscht.

Benannter Bereich und Formelausdruck

Benannter Bereich

Einzelnen Zellen und Zellbereichen kann ein Name zugewiesen werden. Damit werden Formeln, in
denen die Namen verwendet werden, besser lesbar und die Pflege des Dokuments wird erleich-
tert. Wird ein Zellbereich an mehreren Stellen im Dokument verwendet, dann muss eine Anderung
seiner Grof3e oder Position durch die Verwendung des Namens nur in der Festlegung des Namens
geandert werden und nicht an jeder Stelle der Verwendung.

Jan Namen festlegen x |

lse

Norbert Legen Sie den Namen und den Bereich oder Formelausdruck fest.

Martina Name:

Ingrid (

Jochen ‘ Freunde | I

LElEES Bereich oder Formelausdruck: _
| $Tabelle1.9B$25:5B$31 [=]]

Geltungsbereich:

‘ Dokument (global) ~ |

~ Bereichsoptionen

[JDruckbereich [Jwiederholungsspalte
[JFilter [Jwiederholungszeile
\ Hilfe \ | Hinzufiigen || Abbrechen ||

44
Abbildung 10: Benannten Bereich festlegen

Ein benannter Bereich wird mit Tabelle > Benannte Bereiche > Festlegen im Dialog Namen
festlegen erzeugt (siehe Abbildung 10).

Im Feld Name kann der Name des Bereichs gewahlt werden, hier sind Buchstaben, Zahlen und
Unterstriche aber keine Leerzeichen zulassig, und der Name darf keine Zelladresse sein.

Im Feld Bereich oder Formelausdruck kann der Bereich eingegeben werden, war beim Offnen des
Dialogs ein Zellbereich im Arbeitsbereich ausgewahlt, dann ist dieser Bereich in diesem Feld
bereits vorbelegt. Ohne den Dialog zu schlieRen, kann im Arbeitsbereich ein Bereich ausgewahlt
werden, dazu kann mit dem Feld rechts dieses Eingabefeldes der Dialog zu einer
Zeile eingeklappt und wieder ausgeklappt werden.
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Im Auswahlmeni Geltungsbereich wird ausgewahlt, ob der Name fiir das ganze Dokument oder
fur eine der Tabellen in dem Dokument gelten soll. So kann z. B. in jeder Tabelle unter dem
gleichen Namen jeweils ein eigener Bereich festgelegt werden. Die hier gewéhlte Tabelle muss
auch nicht die Tabelle sein, in dem sich die benannten Zellen befinden, es kann also wie ein tabel-
lentibergreifender Bezug benutzt werden.

Nach Aufklappen mit der Schaltflache » |Bereichsoptionen | kénnen Einstellungen fiir Drucken und
Filter gewahlt werden:
= Druckbereich — Der benannte Bereich wird zugleich zu einem Druckbereich (siehe Format
> Druckbereiche, Calc Handbuch Kapitel 6 Drucken, Exportieren, und E-Mails versenden).
= fjlter — Der benannte Bereich wird zugleich zu einem erweiterten Filter (siehe Daten >
Weitere Filter > Spezialfilter, Calc Handbuch Kapitel 2 - Eingeben und Bearbeiten von
Daten).
= Wiederholungsspalte, Wiederholungszeile — Der Bereich wird in Format > Druckbereiche
> Bearbeiten als eine Wiederholungsspalte bzw. -zeile angeboten (aber noch nicht

festgelegt).
Ein benannter Bereich kann auch direkt festgelegt werden, indem ein | GEEE B2
Zellbereich ausgewahlt und im Namensfeld des Hauptfensters der ' R -_
gewiinschte Name eingetragen wird, siehe Abbildung 11.
Die benannten Bereiche kdnnen mit dem Dialog Namen verwalten @2
Uber Tabelle > Benannte Bereiche > Verwalten bearbeitet werden. Norbert
Dieser Dialog ist auch erreichbar mit Namen verwalten im mg:;“a
KontextmenU einer Zelle, die in einem benannten Bereich enthalten ist. Jochen
Aus der Liste aller benannten Bereiche kann der zu bearbeitende T

Name ausgewahlt und dann die Einstellungen wie in Namen festlegen A‘l;bil_dung 11: Benannter
geandert und mit tibernommen werden. Bereich

Benannte Bereiche kdnnen mit Tabelle > Benannte Bereiche > Einfliigen oder durch Eingabe
eines Gleichheitszeichen = und dem Namen des Bereichs in einer Zelle oder Formel verwendet
werden.

Benannter Formelausdruck

In diesem Dialog (siehe Abbildung 10) kann anstelle des benannten Bereichs auch ein benannter
Formelausdruck festgelegt werden. Im Feld Bereich oder Formelausdruck wird dazu eine Formel
(ohne Gleichheitszeichen) eingegeben (jedoch kdnnen die Zellen zur Eingabe nicht interaktiv im
Arbeitsbereich ausgewahlt werden).

Wird die Tabelle in den Beziigen nicht angegeben, dann bezieht sich die Formel bei Verwendung
in einer anderen Tabelle nicht auf die gleichen Zellen sondern auf die entsprechenden Zellen in der
anderen Tabelle.

Diese Formel kann dann wie ein benannter Bereich mit Tabelle > Benannte Bereiche > Einfligen
oder durch Eingabe eines Gleichheitszeichen = und des Namens des Bereichs in einer Zelle oder
Formel verwendet werden.

Vorsicht

Hier sollten ausschlief3lich absolute Bezlige eingeben werden! Wird ein relativer
Bezug verwendet, so verandert sich der Bezug in der benannten Formel dadurch,
dass die Formel an einer anderen Stelle in der Tabelle verwendet wird.
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Matrixformeln

Eine Matrix ist ein miteinander verkntipfter Bereich von Zellen in einer Tabelle mit Werten. Bei
einem Bereich, der drei Zeilen und drei Spalten abdeckt, spricht man von einer 3x3-Matrix. Die
kleinste mogliche Matrix ist eine 1x2- oder 2x1-Matrix mit zwei benachbarten Zellen.

Eine Formel, die mit den verschiedenen Werten eines Zellbereichs gleichartige Berechnungen
ausfuhrt, nennt man Matrixformel. Eine Matrixformel unterscheidet sich von anderen Formeln
dadurch, dass sie die angegebene Operation mit allen Zellen einer Eingabematrix gleichermal3en
ausfuhrt. Das Ergebnis einer Matrixformel ist dadurch ebenso eine Matrix, die Ergebnismatrix. Die
Ergebnismatrix hat immer die gleichen Ausmalfie wir die Eingabematrix.

Sollen z. B. in einem Zellbereich die mit 10 multiplizierten Werte eines anderen Zellbereichs gebil-
det werden, ist es also nicht nétig, eine Formel in jede einzelne Ergebniszelle einzugeben, es
muss nur eine einzelne Matrixformel verwendet werden.

Matrixformeln sind sehr hilfreich, wenn die gleiche Berechnung mit vielen Zellen ausgefiihrt
werden muss. Um die Berechnungsmethode zu einem spateren Zeitpunkt zu &ndern, muss nur
eine einzige Formel, namlich die Matrixformel, aktualisiert werden. Matrixformeln belasten den
Arbeitsspeicher auch weniger als viele einzelne Formeln, sie kbnnen dadurch Speicherplatz
sparen. Zudem bietet LibreOffice spezifische mathematische Funktionen fir Matrizen wie
beispielsweise MMULT zur Multiplikation zweier Matrizen oder SUMMENPRODUKT zur Ermittlung
des skalaren Produkts zweier Matrizen (siehe die Kategorie Matrix Funktionen unter
https://wiki.documentfoundation.org/Documentation/-Calc_Functions/List_of _Functions/de).

Matrixformel erstellen

Um eine Matrixformel zu erstellen wird in die linke obere Ecke der gewiinschten Ergebnismatrix
eine Formel mit beliebigen Operationen und Funktionen eingegeben, als Bezug wird der Bereich
der Eingabematrix ausgewahlt und zum Abschluss UMSCHALT+STRG+EINGABETASTE (anstelle der
EINGABETASTE) gedruck.

Zum Erstellen einer Matrixformel mit dem Funktionsassistent wird die linke obere Ecke der
Ergebnismatrix ausgewahlt. im Dialog wird in der Formel als Bezug der Bereich der Eingabematrix
ausgewahlt und links unten das Kontrollk&stchen fiir Matrix aktiviert, damit die Formel als Matrix-
formel gespeichert wird.

In der Matrixformel kann die Eingabematrix mehrfach enthalten sein. Es kann auch ein anderer
Bereich als Bezug angegeben werden, der die gleiche Grol3e wie die Eingabematrix hat. Wird eine
zu kleine Matrix in der Formel verwendet, so sind die Ergebnisse in den nicht abgedeckten Zellen
nicht verfligbar. Eine zu grof3e Matrix wird nicht beanstandet, die dartiber hinaus gehenden Zellen
werden nicht ausgewertet.

E1:G4 \ - | fx I+ = {zA1:C4+I1:K4+{1.12.23;34.45.56;1.1.1,2.2.2}}
A B o D H J K
34 34 43 1 2 3
567 21 3 4 5 6|
5 654 2 7 8 9,
4 333 997 10 11 12,

Abbildung 12: Beispiel einer Matrixformel
In Abbildung 12 ist als Beispiel die Ergebnismatrix E1:G4 (3 Spalten x 4 Zeilen) als Summe aus

der Eingabematrix A1:C4, der Eingabematrix /1:K4, und einer eingebetteten Matrix
{1.12.23;34.45.56,1.1.1,2.2.2} dargestellt.
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Hinweis

LibreOffice Calc stellt Matrixformeln in geschweiften Klammern dar. Es ist nicht
mdglich, durch manuelle Eingabe der geschweiften Klammern Matrixformeln zu
erzeugen (siehe jedoch Eingebettete Matrizen).

Matrixformel bearbeiten

Die einzelnen Zellen einer Ergebnismatrix sind vor Anderungen geschiitzt. Die Matrixformel kann
nur bearbeitet werden, wenn der gesamte Zellenbereich der Ergebnismatrix ausgewabhlt ist. Dies
kann manuell erfolgen oder durch Auswéhlen einer Zelle darin und der Eingabe STRG+/ (Schrag-
strich) - hierbei muss die /-Taste im Nummernblock verwendet werden.

Wurde die gesamte Ergebnismatrix markiert, kann die Formel in der Eingabezeile bearbeitet und
die Anderung mit UMSCHALT+STRG+EINGABETASTE bestétigt werden.

Um eine Matrixformel mit dem Funktionsassistenten zu bearbeiten, muss ebenfalls die gesamte
Ergebnismatrix markiert werden. Im Dialog des Funktionsassistent ist dann die Schaltflache Matrix
aktiviert.

Eine Matrixformel wird geldscht, indem die gesamte Ergebnismatrix markiert und die Taste ENTF
gedruckt wird.

Eingebettete Matrizen

Calc unterstlitzt eingebettete Matrizen. Elemente darin kénnen eine konstante Zahl, eine logische
Konstante (WAHR, FALSCH) oder ein in Anfilhrungszeichen eingeschlossener Text sein. Eingebet-
tete Matrizen kdnnen eine oder mehrere Zeilen und eine oder mehrere Spalten enthalten, alle
Zeilen mussen dieselbe Anzahl von Elementen enthalten, die Elemente missen jedoch nicht alle
vom gleichen Datentyp sein. Zellbeziige und Namen kdnnen nicht verwendet werden. Eingebettete
Matrizen kénnen nicht verschachtelt werden. Beispiele sind in Tabelle 6 aufgefihrt.

Eine eingebettete Matrix und die Werte darin miissen durch das Einschliel3en in geschwungene
Klammern { und } und durch Spalten- und Zeilentrennzeichen definiert werden. Die Trennzeichen
sind abhangig von der Sprache und dem Gebietsschema, siehe der Abschnitt Trennzeichen in
Extras > Optionen > LibreOffice Calc > Formel. Bei deutscher Gebietseinstellungen wird der
Punkt . als Spalten- und das Semikolon ; als Zeilentrennzeichen verwendet. Eine eingebettete
Matrix belegt wie eine Matrixformel ihrer Grof3e entsprechend Zellen in der Tabelle.

Tabelle 6: Beispiele von eingebetteten Matrizen

eingebettete Matrix Beschreibung
={1.2.3} Matrix mit einer Zeile bestehend aus den drei Zahlen 1, 2, und 3.
={1.2.3;4.5.6} 3x2-Matrix aus 2 Zeilen mit jeweils 3 Werten.

={0.1.2;FALSCH.WAHR."zwei"} Matrix aus 2 Zeilen mit gemischten Datentypen in der zweiten Zeile

=SIN({1.2.3}) Matrixformel mit konstanten Funktionsparametern,
liefert den Sinus der drei Werte 1, 2 und 3.

=A1:B4+{3.-3;2.-2;1.-1,;0.0} eingebettete 2x4-Matrix als konstanter Summand einer
Matrixformel

Impliziter Schnittpunkt von Matrixformeln

Wird in einer Formel (nicht Matrixformel) ein Zellbereich angegeben, der nur eine Zeile oder nur
eine Spalte umfasst, so wird flir den Bezug der implizite Schnittpunkt wie in einer Matrixformel
verwendet. Dies ist der Schnittpunkt des angegebenen Zellbereiches mit der Zeile oder Spalte, in
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der sich die Formel befindet. Wenn es keinen Schnittpunkt gibt, d.h. die Formel sich au3erhalb der
Lange des Bereiches befindet, oder wenn der angegebene Bereich mehrere Zeilen oder Spalten
umfasst, wird ein Fehler angezeigt.

. o . [ | - | fx £ - =[=1114+100}
Bei dem Beispiel in Abbildung 13 steht in E K -
10

L1:L4 zum Vergleich eine Matrixformel,
Bl 104}, 104

1 2
die die Zahl 100 zur Eingabematrix /1:/4 : 2 —
addiert. In M2 wird nun der implizite 10 11 110
Schnittpunkt in der Formel =/1:/4+100 5 _

verwendet: Die Zelle der Eingabematrix
11:14, die auf gleicher Hohe wie die
Formel in M2 liegt, also 12, wird fUr die Addition verwendet. Die gleiche Formel in M3 verwendet /3,
in M6 liegt sie aul3erhalb der Eingabematrix und erhélt keinen Ergebniswert.

.
n o
4

Abbildung 13: Impliziter Schnittpunkt einer Matrixformel

Formeln 18



Funktionen

In Calc sind uber finfhundert Funktionen verfigbar, um Daten zu analysieren und zu verarbeiten.
Diese Funktionen bearbeiten Zahlen, Datum und Uhrzeit oder auch Text. Einfache Funktionen
addieren z. B. Zahlen oder bilden den Mittelwert eine Liste von Zahlen, komplexe Funktionen
errechnen die Standardabweichung oder den Hyperbeltangens einer Zahl.

Der Name einer Funktion gibt meist verkirzt die Operation an, die die Funktion anbietet. Zum
Beispiel kann man mit ZW den Zukunftswert einer Investition berechnen, oder mit BININHEX eine
Binarzahl in eine Hexadezimalzahl umrechnen. Der Name einer Funktion kann in Grof3buchstaben,
in Kleinbuchstaben oder gemischt eingegeben werden.

Einige grundlegende Funktionen bieten das Gleiche an wie Operationen, z. B. der Operator + und
die Funktion SUMME addieren ihre Argumente und der Operator * und die Funktion PRODUKT
multiplizieren ihre Argumente.

Funktionen erhalten Argumente, die in der Berechnung benutzt werden, eine Funktion ohne
Argumente ist jedoch z. B. P/, die ohne Argument die feste Zahl 1t liefert. Viele Funktionen sind
selbsterklarend, die Argumente mussen jedoch ggf. in der passenden Reihenfolge angegeben
werden. Die Argumente sind dazu im Funktionsassistent und in der Seitenleiste in der Funktions-
beschreibung erklart. Die Argumente werden von Hand angegeben oder auch als Bezug interaktiv
gewabhilt.

Verandert sich der Wert in einer durch Bezug angegebenen Zelle, so andert sich das Ergebnis
einer Funktion automatisch entsprechend.

Hinweis

Die Funktionen sind unter https://wiki.documentfoundation.org/Documentation/Calc_ -
Functions/List_of Functions/de in Kategorien aufgelistet und ausfiihrlich beschrieben.

Kompatibilitat mit anderen Programmen

Die meisten Funktionen in Calc folgen dem Open Document Format for Office Applications, Part 2
OpenFormula (ISO/IEC 26300-2:2015, s. https://wiki.oasis-open.org/office/About _OpenFormula).
Da Calc den Standard OpenFormula unterstitzt, ergibt sich eine weitgehende Kompatibilitat der
Funktionen mit allen anderen Programmen fir Tabellenkalkulation, die diesem Standard ebenfalls
folgen. Einige Funktionen in Calc entsprechen dem Standard nicht, insbesondere um den
Austausch von Dokumenten zwischen Calc und Excel zu verbessern.

Im Sinne einer sehr hohen Interoperabilitdt kann Calc Kalkulationstabellen von vielen verschiede-
nen Programmen 6ffnen und in vielen verschiedenen Formaten speichern. Beziiglich Microsoft
Office ist es sehr unkompliziert, Dateien mit Kalkulationstabellen auszutauschen.

Wenn Calc eine Kalkulationstabelle von Excel 6ffnet, werden automatisch Schritte ausgefiihrt, um
Inkompatibilitaten mit bestimmten Funktionen zu vermeiden. Enthélt zum Beispiel eine Excel-Datei
die Funktion OBERGRENZE, wird diese automatisch in OBERGRENZE.EXCEL umgewandelt.
Entsprechend werden Inkompatibilitaten vermieden, indem beim Speichern in Excel-Format
automatisch Funktionen umgewandelt werden, z. B. wird die Funktion UNTERGRENZE in
UNTERGRENZE.MATHEMATIK Ubersetzt.

Die Wiki-Seite der Open Document Foundation bietet einen Vergleich der Funktionalitat von
LibreOffice und Microsoft Office unter https.//wiki.documentfoundation.org/Feature_Comparison._ -
LibreOffice_-_ Microsoft_Office/de. Dieser Vergleich zeigt, dass Calc derzeit 508 einzelne Funktio-
nen anbietet, nur 29 davon sind spezifisch fir Calc, alle anderen haben eine Entsprechung in
Excel. Natiirlich gibt es eine hohe Ubereinstimmung des Funktionsumfangs von Calc und Excel,
und viele Funktionen kénnen in den beiden Programmen in gleicher Weise verwendet werden.
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In einigen Fallen liefert eine Funktion von Calc ein dem internationalen Standard entsprechendes
Ergebnis, dieses unterscheidet sich jedoch von dem von der entsprechenden Excel-Funktion gelie-
ferten Ergebnis. Dazu gibt es in Calc oftmals Funktionen mit einer entsprechenden Erweiterung
des Namens wie _ EXCEL2003 oder _ADD, die das gleiche Ergebnis wie die Excel-Funktion
liefern.

Struktur von Funktionen

Funktionen haben eine einheitliche Struktur. Man muss diese Struktur nicht genau kennen, wenn
man die passenden Hilfsmittel dazu verwendet. Fir die Fehlersuche ist das Wissen darum aber
hilfreich. Ein typisches Beispiel einer Funktion ist ERSETZEN(Text; Position; Ladnge; Neuer Text),
siehe https.//wiki.documentfoundation.org/Documentation/Calc_Functions/REPLACE/de.

Durch umfangreiche Verwendung von Funktionen kann der Inhalt einer Zelle in seiner Komplexitat
sehr ahnlich einer Skriptsprache werden.

Eine Funktion wird immer als Teil einer Formel verwendet, daher muss in der Zelle zu Beginn ein
Gleichheitszeichen = stehen, auch wenn nur die Funktion in der Formel enthalten ist, also z. B.
=ERSETZEN(...). Der Funktionsaufruf beginnt mit dem Namen der Funktion gefolgt von seinen
Argumenten, die in runde Klammern (und ) gesetzt und durch Strichpunkte getrennt werden.

Argumente kdnnen obligatorisch oder optional sein, z. B. ist in UNTERGRENZE(Zahl [; Signifikanz
[; Modus]]) die Zahl obligatorisch und Signifikanz und Modus sind optional, jedoch muss Signi-
fikanz vorhanden sein, wenn Modus angegeben wird.

Argumente von Funktionen

Als Argument kann ein fester Wert oder ein Bezug angegeben werden. Beispiele fur feste Werte
und Bezlige als Argumente finden sich in Tabelle 7.

Tabelle 7: feste Werte und Bezlige als Argumente

Argument Beschreibung
“Februar* die Anflhrungszeichen zeigen, dass es sich um Text handelt
92,451 Ziffern ohne oder mit einem Komma werden als Zahl interpretiert
“92,451" durch die Anfuhrungszeichen ist das ein Text
92,45,1 Ziffern mit mehreren Kommas werden als Text interpretiert
B4 der Inhalt der Zelle B4
4B unzulassig, als Text muss “4B*“ verwendet werden, als Zelle B4
B2:D9 der Inhalt der Zellen von B2 bis D9, 3 Spalten x 8 Zeilen

Als Argument kann aber auch eine Formel mit Operatoren verwendet werden, z. B. ist
PRODUKT(B4 ; 60 ; 24*7) das Produkt aus dem Inhalt der Zelle B4 mal 60 mal 168.

Als Argument kann wiederum eine Funktion eingesetzt werden, der Funktionsaufruf ist dadurch
verschachtelt, z. B. SUBTRAKTION(MITTELWERT(B2:D9) ; 50) ergibt den Wert, um den die
Zellen B2 bis D9 (3 Spalten x 8 Zeilen) im Durchschnitt Gber der Zahl 50 liegen.

Vor MITTELWERT steht dabei kein weiteres Gleichheitszeichen =, da bereits zu Beginn der Zelle
mit dem Gleichheitszeichen = definiert wurde, dass es sich um eine Formel handelt.
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AutoEingabe und Hilfetipps

Der vermutlich am haufigsten verwendete Weg zur Eingabe einer Funktion ist es, direkt in die Zelle
oder in die Eingabezeile ein Gleichheitszeichen = einzugeben und zu beginnen, den Funktions-
namen zu schreiben. Wenn Extras > AutoEingabe eingeschaltet ist, erscheint dabei ein Hilfetipp,
in dem die mit diesen ersten Buchstaben beginnenden Funktionen vorgeschlagen werden. Rechts
im Hilfetipp steht die Funktionsbeschreibung des ersten, hervorgehobenen Eintrags (Abbildung
14). Mit STRG+TAB und UMSCHALT+STRG+TAB kann man durch die Funktionsvorschlége vorwérts
und ruckwarts blattern, die hervorgehobene Funktion ganz links kann mit der EINGABETASTE besta-
tigt werden.

| SUMME |~ @ v [=MT \_
1[MITTELWERT], MITTELABW, MITTELWERTA und 2 mehr: Berechnet den Mittelwert einer Stichprobe.|
(o) ‘ [=] | | = L ™

=MIT ;
Abbildung 14: Hilfetipp Funktionen

Die Schreibmarke bleibt danach in der Argumentliste stehen und es erscheint ein Hilfetipp, in dem
man nun durch die benétigten Argumente blattern kann, rechts steht die Beschreibung des links
hervorgehoben Arguments (Abbildung 15).

| SUMME | - | fx @ v [=MITTELWERT()

A | s IS o | e | F | ¢ | H
=MITTELWERT() .

P
IMITTELWERT(» Zahl 1; Zahl 2; ... ) : Zahl 1, Zahl 2, ... sind numerische Argumente, die eine, aus einer G
Abbildung 15: Hilfetipp Argumente

Beginnt man hier mit der Eingabe eines Funktionsnamens als Argument, dann erscheint wieder
der Hilfetipp fir die Funktionen und eine weitere Funktion kann als verschachtelter Funktionsaufruf
tibernommen werden.

Funktionen in der Seitenleiste

Ein sehr bequemer Weg, ohne Tippfehler Funktionen einzusetzen ist es, die Seitenleiste zu benut-
zen. Die Funktionen in der Seitenleiste werden sichtbar mit Ansicht > Seitenleiste und der
Registerauswahl Funktionen |fx| rechts in der Registerleiste.

‘:ABRUNDEN ‘ = | xQ < - Funktionen 7%

B C 1 ‘ Alle Funktionen durchsuchen |

=ABRUNDEN(

() [Alle -

IN=1:11 Zuletzt verwendet

ABS Alle
AcCHg Datenbank

ADRE Datum und Zeit
I AGGE Finanzen

e m >

AKTU Information

2

3

4

5

6

7

8

9

10

11 .

12 AMo| Logisch
13 AMO Mathematik
14

15

16

17

18

19

20

21

ANZ/ Matrix
Statistik

Tabelle
Zahl; { Text

\ABRU

Plug-in

RUNdcocrresormoo—crrevorgogooore

Genauigkeit ab.

L I i1 Funktionen

Abbildung 16: Funktionen in der Seitenleiste

Mit Ansicht > Funktionsliste wird direkt dieses Register angezeigt (siehe Abbildung 16).
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Die Liste mit Funktionen kann Alle umfassen oder im Listenfeld auf Kategorien eingeschrankt
werden, eine der Kategorien ist zudem Zuletzt verwendet. Die Liste kann in ,Alle Funktionen
durchsuchen* zuséatzlich nach Namen gefiltert werden. Die Liste mit Funktionen kann durchgeblat-
tert werden, fur die jeweils ausgewahlte Funktion erscheint im Feld unten eine Funktionsbeschrei-
bung. Mit einem DopPPELKLICK auf die Funktion in der Liste oder einem KLick auf die Schaltflache
links Funktion in Tabelle einfiigen || wird der Name der Funktion sowie Platzhalter fiir die
Argumente an der aktuellen Position im Arbeitsbereich eingeftigt. Im Arbeitsbereich missen
schlie3lich die bendtigten Argumente festgelegt werden, Platzhalter fir optionale Argumente
kdnnen hier ggf. entfernt werden.

Funktionsassistent

Die umfangreichste interaktive Unterstlitzung bei der Eingabe einer Funktion findet sich im
Funktionsassistent. Er wird aufgerufen

= mit Einfiigen > Funktion (in der Benutzeroberflache In Registern im Tab Einfiigen),

= in der Rechenleiste mit der Schaltflache Funktionsassistent fx oder

= mit der Taste STRG+F2.
Auf der linken Seite des Dialogs sind die Tabs Funktionen und Struktur verfligbar. Auf der rechten
Seite wird unten im Feld Formel der Bearbeitungsstand der Eingabe in Textform dargestellt. In
Abbildung 17 ist der Dialog mit den beiden alternativen Tabs Funktionen und Struktur dargestellt.

Wird im Arbeitsbereich eine leere Zelle ausgewahlt und der Funktionsassistent aufgerufen, ist der
Tab Funktionen ausgewahlt. Hier kann wie in der Seitenleiste eine Funktion gesucht und in
Kategorien gefiltert werden. Fir die in der Liste darunter jeweils ausgewéhlte Funktion wird auf der
rechten Seite des Dialogs eine Funktionsbeschreibung angezeigt. Mit einem DoPPELKLICK auf die
Funktion oder durch KLICKEN der Schaltflache Wird die Funktion in die Formel tibernom-
men und rechts erscheinen Eingabefelder fir die Argumente.

Die Liste optionaler Argumente kann in der Liste von Argumenten durch Scrollen nach unten ggf.
erweitert werden. Die Argumente kénnen jeweils von Hand in die Eingabefelder eingegeben oder
interaktiv gewahlt werden.

Funktionsassistent x
Funktionen Struktur |MITTELWERT Funktionsergebnis: '4,33757902868672‘
Suchen: Struktur: Berechnet den Mittelwert einer Stichprobe.
| mittel |||~ MITTELWERT = 4,33757
Kategorie: Pl =3,141592653589
( \  SAS$6:$BST =1{4.3;3,5. )
Statistik - Zahl 1 (erforderlich
| Statisti Il - SUMME =8,0463024 | " ( y d) ) ; ; ) -
Funktion: . _ Zahl 1, Zahl 2, ... sind numerische Argumente, die eine, aus einer Grundgesamtheit gezogene, Stichprobe
TAN = 0,546302489 e T
GEOMITTEL -~/ IMDIV="0,5"
GESTUTZTMITTEL |
HARMITTEL 72 Zahl1| fx || PI() =
MITTELABW S A1=75 — . —
MITTELWERT 2l ‘1‘ | $AS6:3BS7 .| |j“|
MITTELWERTA Zahl3 | fx || SUMME(TAN(IMDIV(1;2)) ;A1) || =
MITTELWERTWENN Rl =
Zahl 4| fx || =
MITTELWERTWENNS — s
RANG.MITTELW
SUMQUADABW Formel: Ergebnis: | 4,3375790286867: |
=MITTELWERT(PI() ;$A$6:5BS7;SUMME(TAN(IMDIV(1;2)) iA1))‘
[ Matrix | Hilfe ‘ O Matrix | Hilfe ‘ ‘ Weiter > H Abbrechen H oK |

Abbildung 17: Funktionsassistent

KLICKT man in das Eingabefeld eines Arguments, kann im Arbeitsbereich von Calc eine Zelle oder

ein Bereich als Bezug ausgewahlt werden, dazu kann mit der Schaltflache rechts
dieses Eingabefeldes der Dialog zu einer Zeile eingeklappt und wieder ausgeklappt werden.
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Steht die Schreibmarke im Eingabefeld eines Arguments und wéhlt man auf der linken Seite im
Tab Funktionen eine weitere Funktion mit DoOPPELKLICK auf die Funktion oder durch KLICKEN der
Schaltflache | Weiter], dann wird diese Funktion verschachtelt als Argument in die Formel aufge-
nommen. Durch KLICKEN auf den Namen der Funktion im Feld Formel kann man zwischen der
interaktiven Bearbeitung der einzelnen in der Formel enthaltenen Funktionen wechseln.

Im Feld Formel kann zudem die Formel durch Eingaben in Textform bearbeitet werden.

Durch Wechsel auf der linken Seite zum Tab Struktur kann der Bearbeitungsstand der gesamten
Formel Uberprft werden. In einer hierarchischen Darstellung kénnen die darin enthaltenen Funkti-
onen einzeln ein- und ausgeklappt werden, die Ergebnisse aller Ebenen und etwaige Fehlermel-
dungen sind fir jeden darin enthaltenen Rechenschritt sichtbar.

Wurden alle Argumente festgelegt, wird die Eingabe der Formel mit abgeschlossen.

Wird im Arbeitsbereich von Calc eine Zelle, in der bereits eine Formel enthalten ist, ausgewéhlt
und der Funktionsassistent aufgerufen, dann wird die Struktur der Formel dargestellt. Die Formel
und alle darin enthaltenen Funktionen kénnen dann interaktiv im Funktionsassistent Uberprift und
wie hier oben beschrieben geéndert und weiterbearbeitet werden.

Funktionen verwenden

Fur ungelibte Benutzer mag der Einsatz von Funktionen in Calc zunachst abschreckend erschei-
nen. Man erkennt jedoch schnell, dass Funktionen ein wichtiger Bestandteil von Calc sind, gerade
weil es so uniiberschaubar viele sind. Fir einige Funktionen ist spezifisches Wissen nétig, die
Mehrzahl der Funktionen kénnen jedoch problemlos von jedem verwendet werden.

Unter https.//wiki.documentfoundation.org/Documentation/Calc_Functions/List_of Functions/de
sind alle Funktionen mit ihren Beschreibungen aufgefuhrt. Diese Liste kann in der Auswahlliste
Kategorie durch die Auswahl z. B. von Mathematische Funktionen, Statistische Funktionen oder
Textfunktionen auf eine von ca. 10 Kategorien gefiltert werden.

Die wichtigsten Funktionen betreffen einfache Arithmetik oder Statistik und werden hier erlautert.

Einfache Arithmetik

Einfache Arithmetik umfasst die vier Grundrechenarten Addition, Subtraktion, Multiplikation und
Division, hierfiir gibt es jeweils eine Funktion:

= SUMME fur die Addition,

» SUBTRAKTION fiir die Subtraktion,

= PRODUKT fir die Multiplikation und

= QUOTIENT flr die Division.

Die vier Grundrechenarten werden haufig jedoch bevorzugt als Formel mit den Operatoren +, -, *
und / verwendet und sind so, zumal unter Verwendung von Klammern (und ), zumeist tbersichtli-
cher. Ahnliches gilt fir die Potenzfunktion, die als Funktion POTENZ oder als Operator ~ verfiigbar
ist. So sind z. B. A1*(A2+A3) klarer als PRODUKT(A1,SUMME(A2,A3)) und A1"4 klarer als
POTENZ(AL,4).

Ihre Grenzen finden die Operatoren darin, dass Bereiche als Bezug nicht verwendet werden
kénnen. Die SUMME(A1:B3) ist durch den Bereichsoperator besser erkennbar und weniger fehler-
anfallig als A1+A2+A3+B1+B2+B3.

Statistik

Typisch fir Daten in einer Tabellenkalkulation sind umfangreiche Listen von Zahlen wie Waren-
bestande, Einnahmen und Ausgaben oder andere Verwaltungsdaten. Statistische Informationen
darUber geben zumeist den schnellsten Uberblick auch von sehr umfangreichen Daten.
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Die wichtigsten Kennzahlen uber solche Daten kénnen auch in Formeln mit Operatoren oder
Funktionen der Grundrechenarten gebildet werden, mit der GroRR3e des Datenumfangs sind jedoch
spezifische Statistikfunktionen weit besser. In der Regel wird dabei ein Zellbereich als Argument
der Funktion angegeben, da die Liste der Zellen andernfalls zu umfangreich ware, es kénnen auch
nicht mehr als 255 einzeln angegebene Argumente eingesetzt werden.

Die einfachste statistische Funktion ist wohl ANZAHL, die die Anzahl der Zahlen in einem Bereich
liefert (und Text und leere Zellen nicht mitzanhlt).

MIN und MAX bestimmt den kleinsten und grof3ten Wert in einer Reihe. MINA und MAXA werten
einen Text in den Zellen dabei als Zahl 0, so kdnnen erklarende Texteingaben wie z. B. “entfallt”
oder “leer” mit bewertet werden. Mit KKLEINSTE und KGROSSTE kann statt des ersten bzw.
letzten der Wert mit einem bestimmten Rang in der Reihenfolge gesucht werden, z. B. liefert
KGROSSTE(C2:C999, 3) den drittgroRten Wert. Mit Matrixformeln und als Parameter Eingebettete
Matrizen kann sogar sehr einfach eine Highscoreliste erzeugt werden, z. B. die ersten funf Platze
mit KGROSSTE(C2:C999;{1.2.3.4.5}).

Diese Funktionen kénnen z. T. auch durch Sortieren oder Filter angezeigt werden (siehe Calc
Handbuch Kapitel 14 - Calc als Datenbank verwenden). Jedoch sind hier die Méglichkeiten starker
eingeschrankt und nicht so flexibel wie die Statistikfunktionen.

Fir so komplexe Berechnungen wie die Poisson- (POISSON) oder Binominalverteilung (BINOM-
VERT) und viele weitere existieren Funktionen, aber auch so einfache wie MITTELWERT fur die
einfache Durchschnittsbildung, und wieder MITTELWERTA, bei dem Texteintrage mit O bewertet
werden.

Hilfreich fir die Lesbarkeit von Ergebnissen ist es haufig, gerundete Werte anzuzeigen. Mit
RUNDEN, VRUNDEN, AUFRUNDEN, ABRUNDEN und RUNDENSIG steht eine weite Palette von
Funktionen bereit, mit der auf ganze Zahlen, Zehntel, Hundertstel, Zehner, Hunderter usw. oder ein
Vielfaches einer anderen Basis gerundet werden kann.

Volatile Funktionen und Neuberechnung

Volatilitat bezeichnet etwas Flichtiges und Unbesténdiges, volatile Funktionen kénnen ihren Wert
verandern, ohne dass sich ihre Argumente geandert haben. Die Open Document Format for Office
Applications (OpenDocument) definiert, dass volatile Funktionen immer neu berechnet werden,
wenn irgend eine Neuberechnung stattfindet.

Typische volatile Funktionen sind ZUFALLSZAHL und ZUFALLSBEREICH, die zufallige Zahlen
liefern. Wird eine dieser Funktionen in einer Zelle der Tabelle eingetragen, so wird darin jedes Mal
eine neue zuféllige Zahl berechnet, wenn in irgend einer anderen Zelle eine Anderung eingetragen
wird. Dem entsprechend fuhrt die umfangreiche Verwendung volatiler Funktionen zu einer Mehrbe-
lastung des Systems.

Die Neuberechnung wird ebenfalls ausgeltst durch Daten > Berechnen > Neu berechnen oder
die Funktionstaste F9.

Volatile Funktionen in Calc sind:
m ZUFALLSZAHL, ZUFALLSBEREICH,
» HEUTE, JETZT,
» INDIREKT, FORMEL und VERSCHIEBUNG.

Die tUberwiegende Zahl der Funktionen in Calc sind permanente, nichtfliichtige Funktionen, das
Gegenstiick zur volatilen Funktion, z. B. alle arithmetischen Funktionen. Hier wird der Inhalt
berechnet, wenn ein Wert sich &ndert, von dem die Funktion abhangt. Eine Neuberechnung kann
manuell durch Daten > Berechnen > Unbedingte Neuberechnung oder UMSCHALT+STRG+F9
ausgeldst werden.

Permanente Funktionen werden reguldr auch neu berechnet, wenn das Dokument geéffnet wird.
Aktuelle Versionen von LibreOffice legen jedoch zwischengespeicherte Formelergebnisse in ihrer
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ODF-Datei ab, sodass beim Offnen der Datei nicht alle Formeln neu berechnet werden miissen. In
Extras > Optionen > LibreOffice Calc > Formel kann das Neuberechnen fur Dateien von Excel
2007 und neuer und fur ODF-Dokumente, die nicht mit LibreOffice gespeichert wurden, gewahlt
werden.

Die Funktionen ZUFALLSZAHL.NF und ZUFALLSBEREICH.NF sind permanente Alternativen, die
zuféllige Zahl wird hier einmalig und bei jedem Offnen des Dokuments berechnet. Durch Daten >
Berechnen > Neu berechnen oder die Funktionstaste F9 wird die Funktion nur dann neu berech-
net, wenn die Zelle dabei ausgewabhilt ist.

Platzhalter und Regulare Ausdriicke

In vielen Funktionen von Calc kénnen reguléare Ausdrticke in den Argumenten verwendet werden.
Regulare Ausdricke sind eine sehr leistungsfahige Mdglichkeit, nach Mustern in Text zu suchen.
Ein einfacherer, weniger komplexer Weg sind die Platzhalter (Wildcards). In beiden Fallen werden
bestimmte Zeichen mit besonderer Bedeutung (Metazeichen) zur Verwendung in dem zu suchen-
den Textmuster definiert.

Unter Extras > Optionen > LibreOffice Calc > Berechnen Ilasst sich wahlen zwischen

= Platzhalter in Formeln ermdglichen (Standard),

= Reguldre Ausdrticke in Formeln ermdéglichen oder

= keine Platzhalter oder reguléaren Ausdriicke in Formeln.
Zu Beachten ist, dass eine Anderung dieser Einstellung Anpassungen in allen Zellen erfordern, die
Platzhalter oder reguléare Ausdriicke enthalten, und ggf. auch in denjenigen Zellen, die Zeichen mit
dann besonderer Bedeutung enthalten aber nicht entsprechend interpretiert werden sollen.

Die regularen Ausdriicke von Calc kénnen nicht genutzt werden, sofern fur die Datei Interoperabili-
tat mit Excel benotigt wird, da Excel dies nicht im gleichen Mal3e untersttitzt. In diesem Fall kénnen
nur die einfachen Platzhalterzeichen benutzt werden, die ohne Verlust der Funktionalitat in Excel-
Format exportiert werden kénnen. Wenn unter Extras > Optionen > LibreOffice Calc > Berech-
nen die Einstellungen Platzhalter in Formeln ermdglichen und Suchkriterien = und <> muissen auf
ganze Zellen zutreffen gewahlt sind, verhalt sich Calc genau so wie Excel.

Die Funktionen, die Platzhalter oder regulare Ausdriicke unterstitzen, sind:

= DBMITTELWERT, DBANZAHL, DBANZAHL2, DBAUSZUG, DBMAX, DBMIN,
DBPRODUKT, DBSTDABW, DBSTDABWN, DBSUMME, DBVARIANZ, DBVARIANZEN
(alle Datenbankfunktionen)
MITTELWERTWENN, MITTELWERTWENNS, ZAHLENWENN, ZAHLENWENNS,
MAXWENNS, MINWENNS, SUMMEWENN, SUMMEWENNS (Statistikfunktionen)
VERWEIS, WVERWEIS, SVERWEIS (Tabellenfunktionen)
VERGLEICH
SUCHEN (nicht jedoch SUCHENB)
REGAUS (interpretiert regulare Ausdriicke unabhangig von der Einstellung Platzhalter in
Formeln in Extras > Optionen > LibreOffice Calc > Berechnen, d. h. hier kdnnen regulare
Ausdriicke auch dann verwendet werden, wenn Regulére Ausdriicke in Formeln ermogli-
chen nicht eingestellt ist. Diese Funktion entspricht keinem ODF-Standard und ist in Excel
nicht verfigbar.)

Genaue Beschreibungen der Funktionen finden sich in der Liste der Funktionen im TDF Wiki:
https://wiki.documentfoundation.org/Documentation/Calc_Functions/List_of_Functions/de.

Platzhalter und Reguléare Ausdriicke finden im Textvergleichsoperator (z. B. A2="blau”) keine
Anwendung. Stattdessen kann jedoch z. B. ZAHLENWENN(AZ2; "*au") verwendet werden, damit
liefern “blau” und “grau” die Zahl 1 und “gelb* liefert 0.
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Platzhalter

Der Gebrauch von Platzhaltern ermdglicht eine einfachere gezielte Suche in einem Text. Nur die
drei Zeichen Fragezeichen ?, Sternchen * und Tilde ~ sind hier als Metazeichen definiert:
= Das Fragezeichen ? wird im Suchtext fiir ein beliebiges einzelnes (genau ein) Zeichen
eingesetzt. Das Muster “T?m* findet “Tim“ und “Tam* aber nicht “Tm* und nicht “Traum*.
= Das Sternchen * wird fur eine beliebige Anzahl von Zeichen (auch die Anzahl 0) eingesetzt.
Das Muster “R*um* findet, “Raum*, “Radium“ und “Rum* aber nicht “Ruhm*.
= Mit einer vorangestellten Tilde ~ kann die Bedeutung der Metazeichen ? und * entwertet
werden, um mit ~? nach dem Fragezeichen und mit ~* nach dem Sternchen zu suchen.

Die Platzhalter unterscheiden nicht nach Grof3- und Kleinschreibung, die Suche nach "Hut" findet
sowohl "hut" als auch "huT" und "HUT".

Weitere Beispiele und Erlauterungen siehe
https://help.libreoffice.org/24.2/de/text/scalc/guide/wildcards.htmI?DbPAR=CALC#bm_id3152149.

Regulare Ausdriicke

Fur regulare Ausdricke ist der Umfang von Metazeichen gréBer:. ~ $ * + 2\ [ ]| {} ()
Die Regeln zur Definition von Suchmustern ist erheblich komplexer und dementsprechend
leistungsfahiger. In https://help.libreoffice.org/24.2/de/text/shared/01/02100001.html ist die Liste
der Metazeichen erlautert.

Calc nutzt das Regular Expressions package der International Components for Unicode (ICU) fur
die Implementierung der reguléren Ausdriicke, die genaue Funktion und alle Metazeichen sind hier
https.//unicode-org.github.io/icu/userguide/strings/regexp.html ausfuhrlich beschrieben (in
Englisch).

Die regularen Ausdricke unterscheiden ebenfalls nicht nach Grol3- und Kleinschreibung, jedoch ist
es — aulRer in den Datenbankfunktionen — mit der Flag option durch Einfiigen von “(?-i)“ in das
Suchmuster mdglich, das case insensitive matching auszuschalten.

Fur die wichtigsten Metazeichen sind hier einige kurze Beispiele beschrieben:

Tabelle 8: Beispiele fur regulare Ausdriicke

regularer .
Ausdruck Beschreibung
r.t Punkt .: ein beliebiges Zeichen, also rat, rot und r@t, aber nicht rt
Was*er Sternchen *: beliebig viele des Zeichens davor, hier ein s, also Wasser, Waser,
Wasssser und auch Waer
Was+er Pluszeichen +: ein oder mehrere des Zeichens davor, hier ein s, also Wasser,
Waser, Wasssser aber nicht Waer
Mau?l Fragezeichen ?: keinmal oder einmal das Zeichen davor, hier ein u, also Mal
oder Maul, aber nicht Mahl/
Be[srljt eckige Klammern [ und J: genau eines der enthaltenen Zeichen, also Best, Bert
oder Belt, aber nicht Berlt
Was{2,4}er geschweifte Klammern { und }: genau 2 bis 4 des Zeichens davor, hier ein s, also

Wasser, Wassser, und Wasssser, aber nicht Waer, Waser und Wassssser

Blaeiou]{1,2}r das Zeichen vor den geschweiften Klammern kann auch ein Metazeichen sein,
hier also genau ein oder 2 Vokale zwischen B und r: Bar, Baer, Bier, Bor aber

nicht Bauer
T Zirkumflex, Caret ~: der Buchstabe T am Zellanfang
ung$ Dollarzeichen $: das Wortende ung am Zellenende
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regularer )
Ausdruck Beschreibung

A *ung$ eine Zelle beginnt mit A und endet mit ung, dazwischen beliebig viele und belie-
bige Zeichen, also Achtung und Ahnung, aber nicht Alling

Benutzerdefinierte Funktionen

In Calc kbénnen benutzerdefinierte Funktionen als Makros hinzugefligt werden. Makros werden in
den Menufunktionen unter Extras > Makros verwaltet und kénnen in Basic, Python, JavaScript,
oder BeanShell programmiert werden. Unter Extras > Makros > Makros bearbeiten ist dies
mithilfe der Basic-IDE auch ohne umfangreiche Programmierkenntnisse maglich.

Genaueres findet sich im Calc Handbuch Kapitel 13 — Makros.

Funktionen
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Strategien fiir komplexe Tabellen

Die Berechnungen in einer Tabelle bleiben in den seltensten Féllen ganz einfache tbersichtliche
Operationen. Meist bestehen die Operationen aus komplexen Strukturen oder werden nach und
nach immer komplexer. Daher ist es ratsam, die Operationen stets von vornherein strukturiert
aufzubauen, da die Tabelle andernfalls bald unubersichtlich und kaum mehr zu bearbeiten sein

wird.

Nachfolgend finden sich Ratschlage fir einen guten Aufbau.

In jeder Zelle eine eigenstiandige Formel

Naheliegend und fir eine kleine einfache Tabelle am schnellsten ist es, in jede Zelle eine Formel
mit der vollstdndigen Berechnung des gewiinschten Wertes zu platzieren.

Dies ist nur dann sinnvoll, wenn die Tabelle sehr klein ist, ohne groRen Aufwand erstellt werden
kann und nichts davon wiederverwendet werden soll. Wird diese Tabelle schliel3lich doch weiterge-
pflegt, dann ergibt sich bald ein unnétig hoher Aufwand. In der Regel ist dieser einfache Weg

daher nicht zu empfehlen.

Berechnungen aufbrechen

Berechnungen werden in Teile aufgegliedert
und diese zu einer gesamten Berechnung
kombiniert.

Im Beispiel in Abbildung 18 soll der Betrag
einer Rechnung aus den Mengen und Preisen,
der Steuer und dem Porto berechnet werden.
Dies kann wie in der Zelle C8 in einer einzigen
Zelle erfolgen oder wie in Spalte D in Zwische-
nergebnisse aufgeteilt werden. Hier ist gut
erkennbar, dass die Berechnung in einer einzi-
gen Zelle sehr untibersichtlich ist.

1
2
3
4
5
6
7

9
10
11

Ubersicht in der ersten Tabelle

A B | C | D

Anzahl Produkt Einzelpreis

2 Bleistift 0,20 €, =A2*C2

4 Filzstift 0,45 €, =A3*C3

1 Radiergummi 0,70 €4 =A4*C4

» =SUMME(D2:D4)

19,00 % Mehrwertsteuer N =A6*D5

Porto 4,50 €, =C7

'-_E =SUMME(D5:D7)

=((A2*C2)+(A3*C3)+(A4*C4))*(1+A6)+C7

Abbildung 18: Berechnungen aufbrechen

Der ersten Tabelle kommt in einer Datei eine besondere Bedeutung zu, hier sollten sich alle grund-
legenden Informationen wiederfinden. Hierzu gehéren vor allem EingabegréfZen oder Konstanten
sowie Gesamtergebnisse. Komplexere, umfangreichere Berechnungen kénnen in weitere Tabellen

dahinter angeftigt werden.

In der ersten Tabelle sollte dann auch eine Dokumentation in Textform untergebracht werden, z. B.
Erklarungen zum Zweck der Berechnung, Bedeutung der Eingabegréf3en und Ergebnisse,
verwendete Algorithmen und vorausgesetzte Randbedingungen.

Berechnungen beschleunigen

Tabellenkalkulationen werden haufig verwendet, um umfangreiche Rohdaten zu verarbeiten und
daraus Zusammenfassungen und Darstellungen von Informationen zu erstellen. In Finanzabtei-
lungen oder Laboren findet man daher Tabellen mit vielen Tausend Zeilen und Spalten. Berech-
nungen, die mit diesen Rohdatensatzen durchgefiihrt werden, kbnnen zeitaufwandig sein.

Strategien fir komplexe Tabellen
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GrolRe Datenmengen mit dementsprechend vielen Tausend Formeln zu verarbeiten, fiihrt zu einer
unnotig hohen Zahl von Formel-Interpretationen und einzelnen Berechnungen. Indem man dies
vermeidet, wird die Verarbeitung wesentlich effizienter.

Matrixformeln fiir groBe Datenmengen

Eine Matrixformel fuihrt eine wiederkehrende Berechnung mit einer groRen Zahl von Datensétzen
aus, ohne dass sie fir jede Berechnung neu interpretiert werden muss, siehe den Abschnitt Matrix-
formeln.

Konsolidieren anstelle vieler einzelner Funktionen

Mit Konsolidieren werden bestimmte Berechnungen mit vielen Eingangsdatensétzen ausgefuhrt.
Die Berechnungen kénnen z. B. Summe, Produkt, Anzahl, Minimum oder Maximum oder statisti-
sche Funktionen sein. Konsolidieren ist im Calc Handbuch Kapitel 10 - Datenanalyse beschrieben.

Makros benutzen

Daruber hinaus kénnen Makros geschrieben werden, um komplexere Operationen, die nicht als
Funktion verfugbar sind, mit einem einzigen Aufruf ausfiihren zu kdnnen. Bei mehrfacher
Verwendung eines Makros wird die Tabelle tibersichtlicher und Anderungen an der Operation
kénnen auf einen einzelnen Ort, die Definition des Makros, konzentriert werden. Nachteilig ist
dabei jedoch, dass ungelibte Benutzer die ausgefiihrten Operationen nicht nachvollziehen kénnen.

Makros sind im Calc Handbuch Kapitel 10 - Makros beschrieben.

Multithreading

Die Fahigkeit moderner Mehrkern-Prozessoren, kann mit Multithreading genutzt werden, sodass
die Verarbeitung parallelisiert und Ausfihrungszeiten damit reduziert werden. Mit Extras > Optio-
nen > LibreOffice Calc > Berechnen kann unter CPU-Threading-Einstellungen die Multithread-
Berechnung aktivieren gesetzt werden, Standard ist aktiviert. Bei dieser Einstellung erkennt und
nutzt Calc selbsttatig, wo Berechnungen parallel ausgefuhrt werden kdénnen. Eine weitergehende
Einstellung ist die Umgebungsvariable MAX_CONCURRENCY von LibreOffice.
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Fehler finden und beheben

Es gibt haufig Situationen, in denen Fehler angezeigt werden. Selbst mit allen Werkzeugen, die in
Calc zur Verfigung stehen, um bei der Eingabe von Formeln zu unterstiitzen, ist es leicht, Fehler
zu machen. Oftmals kommt es bei der Eingabe von Zahlen zu einer Verwechselung mit Text, oder
man bringt die Argumente bei der Eingabe einer Funktion durcheinander. Neben der Korrektur von
Fehlern méchte man vielleicht auch die in einer Formel verwendeten Zellen finden, um deren
Werte zu &ndern.

Fur diese Problemstellungen stehen in Calc mehrere Werkzeuge zur Verfigung, um Formeln und
die Zellen, auf die sie sich beziehen, zu untersuchen und Fehler zu erkennen:

= Fehlermeldungen,

= Farbkennzeichnung bei der Eingabe,

= \Werte hervorheben und

= der Detektiv.

Fehlermeldungen

Die wichtigste Hilfestellung sind die Fehlermeldungen. Fehlermeldungen werden in der Zelle einer
Formel, in der Statusleiste und im Funktionsassistent anstelle des Ergebnisses angezeigt.

Die Fehlermeldung erscheint in der Zelle und enthalt entweder einen dreistelligen Fehlercode als
Zahl im Bereich von 501 bis 540 oder ist ein Wort wie #ZAHL!, #WERT! oder #NAME?. Wenn die
betreffende Zelle ausgewahlt ist, wird ein Fehlertext in der Statusleiste angezeigt.

Fehlermeldungen zeigen ein Problem an, wie eine Formel angegeben wurde, kénnen aber auch
das Erreichen von Beschrankungen in Calc oder aktueller Einstellungen sein.

Auch wenn die Fehlermeldung nicht immer leicht zu verstehen ist, ist sie doch eine wertvolle Hilfe-
stellung, um Fehler zu beseitigen. Erklarungen zur Bedeutung der Fehlermeldungen finden sich im
Calc Handbuch Anhang B - Fehlermeldungen und unter
https://help.libreoffice.org/latest/de/text/scalc/05/02140000.htmI?DbPAR=CALC. Die haufigsten
Fehlermeldungen sind in Tabelle 9 zusammengestellt und einige davon nachfolgend erlautert.

Tabelle 9: Haufige Fehlermeldungen

Fehlermeldung Fehlertext und Bedeutung
#NAME? Ungliltige Namen: Ein Bezeichner konnte nicht aufgelost werden;
(Fehler:525) beispielsweise kein gultiger Bezug, kein gtiltiger Funktionsname, keine

Spalten-/Zeilenbeschriftung, kein Makro, falsches Dezimaltrennzeichen
oder Plug-in nicht gefunden.

#REF! Kein gliltiger Bezug: Ein Beschreibungsname fiir eine Spalte, Zeile oder
(Fehler:524) Tabelle konnte nicht aufgelost werden oder fehlt in einer Formel.

#WERT! Kein Wert: Die Formel ergibt einen Wert, der nicht der Definition entspricht,
(Fehler:519) oder eine in der Formel referenzierte Zelle enthalt Text anstelle einer Zahl.
#DIV/0! Division durch Null: Divisionsoperator / falls der Nenner 0 ist,

(Fehler:532) weitere Funktionen geben diesen Fehler zuriick, zum Beispiel

VARIANZEN, STABWN, VARIANZ und STABW mit zu wenigen
Argumenten oder STANDARDISIERUNG und NORMDIST mit stabw=0

#ZAHL! Unglltige Gleitkommaoperation: Eine Berechnung fuhrt zu einem
(Fehler:503) Uberlauf des definierten Wertebereichs.
Fehler:509 Fehlender Operator: Der Operator fehlt; beispielsweise "=2(3+4)",

wo der Operator "*" zwischen "2" und "(" fehlt.
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Fehlermeldung Fehlertext und Bedeutung

Fehler:510 Fehlende Variable: Eine Variable fehlt; beispielsweise "=1+*2"
wo zwei Operatoren nebeneinander stehen.

Dieser Fehler entsteht entweder durch den Wert 0 | A e I D
oder eine leere Zelle als Bezug im Nenner einer ' 13 ﬁéhler E g
Division. Der Fehler lasst sich vermeiden durch enner

. . . . Il Quotient 0.4
Verwendung einer bgdmgten Funktlon: In Abbil- 16 |bedingt : O,W
dung 19 ergibt die Division =C13/C14 in Zelle C15 17
einen Fehler, in Zelle C16 wird der Fehler durch 13
die Formel =WENN(C14<>0,C13/C14;"unendlich”) ., ucnq 19: Fehler: Division durch Null

vermieden.

#WERT! kein Wert A 5
Der Fehler #WERT! tritt haufig auf und erscheint, wenn einer | 19 |Zahler

Operation oder Funktion ein unpassender Datentyp angege- g gﬁg:g;t

ben wird, z. B. wie in Abbildung 20 gezeigt, wenn ein Text 22 *

anstelle einer Zahl als Operand einer arithmetischen Opera- | 23 =C19/C20
tion angegeben wird. 24

Abbildung 20: Fehler: kein Wert
#REF! kein giiltiger Bezug
Der Fehler #REF! entsteht dadurch, dass ein Bezug fehlt. Haufig tritt dies bei einem Bezug in eine
andere Tabelle auf, wenn der Name der Tabelle von Hand fehlerhaft angegeben oder diese Tabelle

spater geléscht wurde. (Wird eine Tabelle umbenannt, dann werden Bezlige, die diesen Namen
verwenden, angepasst.)

Farbkennzeichnung bei der Eingabe

Eine anschauliche Hilfestellung beim Erstel- A B C D E
len und Untersuchen von Formeln ist die 1L 190 1ficht groBer] _
farbliche Kennzeichnung der Beziige. Beim 2 Die Zahl__List groBer nicht grogerfals ]

BEl-A2& A1& B2 & C1&E2& Bl

Bearbeiten einer Formel wird in der Zelle Abbildung 21: Farbkennzeichnung bei der Eingabe

jeder Bezug in einer anderen Farbe darge-
stellt, und die entsprechenden Zellen im Arbeitsbereich werden in der jeweiligen Farbe umrahmt.
Abbildung 21 zeigt das am Beispiel der Verkettung (vgl. Abbildung 4).

Werte hervorheben

Zellinhalte kénnen sehr ahnlich aussehen, dabei aber unterschiedliche Inhalte reprasentieren. Der
Text “10,35" kann z. B. mit der Zahl 10,35 verwechselt werden. Um die Datentypen leichter zu
erkennen, kénnen sie mit Ansicht > Werte hervorheben oder STRG+F8 in spezifischen Farben
dargestellt werden: Zahlen in blau, Formeln in griin und Text in schwarz. (Eine ggf. eingestellte
Zeichenfarbe wird dadurch in der Anzeige Ubersteuert, jedoch nicht beim Drucken.)

Alle Abbildungen in diesem Kapitel zeigen die Darstellung mit Werte hervorheben.

Der Detektiv

In einer Tabelle mit verschachtelten Beziigen und Zwischenergebnissen ist es manchmal schwie-
rig, die Zusammenhdange einer Formel zu Uberblicken. Der Detektiv kann dazu Spuren zum
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Vorganger und zum Nachfolger einer Kette von
Beziigen und auch eine Spur zu einem Fehler
darstellen. In Extras > Detektiv konnen die
Spuren fur die jeweils ausgewahlte Zelle einge- =A2 2 A1&B2&C1&E2&B1
schaltet, aktualisiert und entfernt werden. Abbil-
dung 22 zeigt zur Abbildung 4 die Spuren zum Abbildung 22: Der Detektiv

Vorganger der Zelle A3 und nach erneutem Aufrufen von Spur zum Vorganger auch die Spuren
zum Vorganger der Zelle C1.

Fehler finden und beheben
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Weitere Informationen

Handbiicher der LibreOffice Community

Die Handbucher fir die einzelnen Anwendungen bestehen aus mehreren Kapiteln. Die Kapitel-
Ubersichten finden Sie auf der Webseite von LibreOffice - The Document Foundation

LibreOffice Handblicher (auf deutsch) / https.//de.libreoffice.org/get-help/documentation/

LibreOffice Handblicher (englische Versionen) /
https://wiki.documentfoundation.org/Documentation/Publications

LibreOffice bietet sechs Anwendungen (Komponenten) fir die Erstellung und Bearbeitung
von Dokumenten und zur Datenverarbeitung:

* Writer - Textverarbeitung

 Calc - Tabellenkalkulation
* Impress - Prasentationen
* Draw - Zeichnungen

* Base - Datenbanken

* Math - Formeleditor

Die Kapitel

Jeder, der sich schnell mit LibreOffice vertraut machen mochte, wird die Kapitel zu schatzen
wissen. Vielleicht sind Sie neu in der LibreOffice Suite oder Sie sind mit eine anderen Office-Suite
vertraut. Die Kapitel von LibreOffice bieten Ihnen themengenaue Informationen.

PDF-Versionen
Alle Kapitel kdnnen frei als PDF-Version heruntergeladen werden:
LibreOffice Handblicher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

Die Autoren

Die Handbiicher werden von Freiwilligen der LibreOffice-Community erstellt.

Uber LibreOffice

LibreOffice ist eine leistungsfahige Office-Suite, fir verbreitete Betriebssysteme wie Windows,
GNU/Linux 32-/64-Bit und Apple Mac OS X geeignet.

LibreOffice entsteht aus der kreativen Zusammenarbeit von Entwicklern und der Gemeinschaft der
Stiftung The Document Foundation / https://de.libreoffice.org/about-us/governance/. Die Stiftung
hat ihren Sitz in Berlin / Deutschland.

Das Programm LibreOffice kann unter der Adresse LibreOffice Download /
https://de.libreoffice.org/download/download/ kostenlos heruntergeladen werden.
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Kapitellibersicht - Calc Handbuch

Kapitel 1 - Einfihrung

Kapitel 2 - Eingeben und Bearbeiten von Daten

Kapitel 3 - Diagramme und Schaubilder

Kapitel 4 - Daten formatieren

Kapitel 5 - Format- und Dokumentvorlagen

Kapitel 6 - Bilder und Grafiken

Kapitel 7 - Drucken, Exportieren, E-Mailen und Signieren
Kapitel 8 - Formeln und Funktionen verwenden

Kapitel 9 - Pivot-Tabellen

Kapitel 10 - Datenanalyse

Kapitel 11 - Daten verkniupfen

Kapitel 12 - Gemeinsame Nutzung und Auswertung von Tabellen
Kapitel 13 - Makros

Kapitel 14 - Calc als Datenbank verwenden

Kapitel 15 - Einrichten und Anpassen

Kapitel 16 - Varianten der Benutzeroberflache

Anhang A - Tastaturkdirzel

Anhang B - Fehlermeldungen

Anhang C - Calc Funktionen

Anhang D - Pivot-Tabellen - Beispiele und Losungsansatze
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Hilfe

So verwenden Sie die Hilfe von LibreOffice.

Offline-Hilfe

Die Offline-Hilfe steht Ihnen nur zur Verfigung, wenn Sie sie auch installiert haben.
Platzieren Sie den Cursor an eine Stelle (Men(, Dialog etc.), an der Sie Hilfe benétigen.
Betatigen Sie die Taste F1, (bei Laptops evtl. FN+F1).

Online-Hilfe

Die Online-Hilfe wird IThnen angeboten, wenn Sie keine Offline-Hilfe installiert haben.
Sie kénnen die Online-Hilfe aber auch direkt in Threm Internetbrowser 6ffnen:
LibreOffice online Hilfe

Offline- und Online-Hilfe

Beide Hilfesysteme 6ffnen sich jeweils in Ihrem als Standard festgelegten Internetbrowser.

Im linken oberen Bereich bei Index befindet sich die Suchleiste. Dort kdnnen Sie Ihre Suchbegriffe
eingeben. Schon bei der Eingabe eines Buchstabens bekommen Sie direkt darunter eine Auswahl
von Themen. Mit jedem weiter Buchstaben konkretisiert sich die Auswabhl.

KLICKEN Sie dann in die Auswahl auf ein Thema, um die Beschreibung dazu im mittleren Bereich
des Fenster zu lesen.

Noch Fragen?

Fur Fragen zum Thema gehen Sie zu Ask.LibreOffice:
Fragen auf ask.LibreOffice

Mitarbeit bei LibreOffice

Besuchen Sie uns auch auf der Seite Dabei sein!:
LibreOffice Community

Spenden

LibreOffice ist freie Software und wird kostenfrei zur Verfligung gestellt. Ihre Spende, die rein
freiwillig ist, unterstitzt unsere weltweite Gemeinschaft. Wenn Ihnen die Software gefallt, freuen
wir uns Uber eine Spende auf Spenden fir die Document Foundation.
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